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JOIN THE CLUB...
Welcome to the world’s  
No.1 weekly digital 
photography magazine. 
If you’re already a 

reader, thanks for your continued 
support and involvement; if you’re 
new to Photography Week, you’ve 
come to the right place! In addition 
to expert advice, brilliant tips and 
step-by-step tutorials, every issue 
features interactive galleries of 
brilliant photos, how-to videos on 

essential shooting and editing 
techniques, and in-depth reviews 
of the latest camera kit. 

But that’s not the whole story. 
Photography Week is more than 
a magazine – it’s a community 
of like-minded people who are 
passionate about photography. 

of the links below and share your 
shots and comments. 
Jeff Meyer, Editor

W E L C O M E

We’re more than just a magazine – read on and discover the many  
ways you can interact with and enjoy Photography Week

JOIN THE PHOTOGRAPHY WEEK 
COMMUNIT Y AND START SHARING! 

FACEBOOK
http://bit.ly/39py9lg

TWITTER 
http://bit.ly/2vGadLP

FLICKR 
http://bit.ly/2VIgsJO

http://bit.ly/39py9lg
http://bit.ly/2vGadLP
http://bit.ly/2VIgsJO
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FUJIFILM UNVEILS 
 

New instant camera lets you 
take control and get creative

F E AT U R E

PERFECT THE PROCESS 
Pro editing tips for enhancing 
landscapes with advanced tools 

P H O T O S

 
Our pick of the best reader 

I N S P I R AT I O N

 
Stunning images celebrate the 
diversity of the UK’s wildlife

C R A S H  C O U R S E

 
Create a striking composite to 
replicate the large-format look

P H O T O S H O P

 
Balance a landscape with the 
Shadows/Highlights tool
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Viltrox lenses have a 
reputation for delivering 
pro-grade performance 
and image quality at an 
affordable price, so can 
this latest fast prime 
repeat the trick?

F E AT U R E
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W H AT ’ S  H O T
THE WEEK’S TOP HEADLINES IN PHOTOGRAPHY

SN E W

INSTAX MINI 99 LETS YOU TAKE 
CONTROL AND GET CREAT IVE 

ujifilm has unveiled its most 

advanced Instax camera to 

date, the Instax Mini 99. The 

new model, which uses Instax Mini film 

packs, adds a host of creative options to 

the ‘instant’ point-and shoot experience, 

including colour effects and vignettes.

The Instax Mini 99 looks a little like 

a cross between the Instax Mini 40 and 

Mini 90 Neo Classic, with the same 

retro rangefinder film camera aesthetic, 

although in a chunkier Instax form.

On the top of the camera are two 

manual dials, one of which enables you 

to apply colour effects including Faded 

Green, Sepia, and Light Leak to images 

via LEDs that flash inside the camera 

as the film is exposed. Other controls 

enable you to adjust the brightness of 

images and add a vignette.

New shooting modes include Sports, 

which uses a faster shutter speed for 

action shots; Indoor, which balances 

exposure for indoor lighting; and 

Double-Exposure. The flash can now 

red-eye removal flash, or turned off.

As well as the Macro mode that’s 

featured on previous Instax cameras 

for subjects between 0.3-0.6m from 

the camera, the focus dial can be set to 

Landscape mode for scencs 3.0m away 

and beyond, and Standard mode for 

subjects in between 0.6m and 3.0m.

There’s a new self-timer mode for 

group shots, and the Mini 99 features 

a 1/4-inch filter thread for mounting 

the camera to a tripod. There’s also a 

Base Grip Tripod Mount accessory for 

additional grip when handheld.

The Instax Mini 99 will be available 

from April 4, priced at £174.99 / $199.99.

F

Fujifilm’s most advanced Instax yet gets colour effects and new focus modes
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COMPLETE GUIDE TO LANDSCAPE
 POST-PROCESSING

Take your best scenic images further using natural editing techniques  
Words Peter Fenech

ery few photographic genres 
offer the same range of lighting, 
colour and detail that can be 

found in a landscape. Changing weather, 
the shifting position of the sun in the sky, 
and the steady progress of the seasons 
afford us the opportunity to capture 
familiar locations in new ways almost 
every day, which goes some way to 
explaining why landscape photography 
is such a popular genre.

The downside of so many 
photographers shooting landscape 
images is that it has become almost 
impossible to capture a truly unique shot 
of a well-known landmark. Instagram 

is awash with photos of places such 
as Durdle Door in Dorset, Yosemite 
National Park in the USA, Lake Louise in 
Banff National Park, Canada, and, more 
recently, the misty skeletal forests of 
Madeira or the wild shores of the Faroe 
Islands. It doesn’t take long for content 
creators to flock to even the remotest 

The solution is not to try and produce 
images that could be taken by anybody 
else, but rather to find new combinations 
of styles and techniques – and while you 
can do this in camera to an extent, the 
editing stage is where you can quickly 

V

NATURAL BALANCE
With careful and targeted 
adjustments in post-processing, 
you can turn your landscape 
images into shots that stand out

Modern image editing software offers 
a wide range of professional features to 
play with, both AI and conventional, and 
although AI hits the headlines regularly 
these days, there are plenty of manual 
filters and colour-grading tools that you 
can use to realise your vision. 

Over the next few pages we’ll take 
a look at the key steps favoured by two 
professional landscape photographers, 
and how they use these to craft a 
signature look for their images. We’ll 
then progress onto high-level landscape 
processing tricks that you can use today 
to get the maximum drama out of all 
your scenic shots.
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UT R EF E A

ne of the aspects you come to 
appreciate as an experienced 
digital photographer is that 

editing is a multi-step process. It’s not 
simply a case of taking the images from 
a camera, applying a standard set of 
adjustments and then sending the files 
to print or archive.

To create the best possible results, 
it’s almost always necessary to 

software, before applying more complex 
local edits, and, finally, retouching in 
applications such as Photoshop or 
Affinity. Landscape photographer Liam 
Willis keeps his editing process refined 
and targeted, integrating his shooting 
and editing workflows.

O

CREATE A BASELINE
Liam Willis explains how you can process your raw files to 

provide the best opportunities for later creative editing

LIAM WILLIS
Liam Willis is a wildlife and 
landscape photographer 
based in Sussex, UK. He 
took up photography in 
2015, focusing on nature 
images, but developed a 

passion for landscape photography. In 
2023, Liam was shortlisted for UK 
Landscape Photographer of the Year and 
The British Wildlife Photography Awards, 
and his picture of a stag, Morning Breath, 

Awards in 2023. 
@mrliamwillis 
liamwillisphotography.sumupstore.com

“Like thousands of others, I travel 

in search of the perfect shot,” he says. 

photographers, but I also like to give it 
my own style; slightly changing the focal 
length, adjusting the composition or 
even the exposure length.” 

“My tutorial will take you through my 
editing process of Tu Hwnt I’r Bont, a 
tearoom next to a bridge in Llanwrst, 
Wales. I picked the wettest week of 
the year, with the River Conwy bursting 
its banks. I used an exposure length of 
0.5 sec and shot at f/22 to give some 
movement to the water. I choose to edit 
using Adobe Lightroom for iOS on the 
iPad, as I don’t own a laptop.”
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DOWN TO THE DETAILS
Raw images often contain far 

more highlight and shadow detail 
than is immediately apparent 

before processing, and this can 
be easily recovered in most apps

https://liamwillisphotography.sumupstore.com/
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CREATE A BASELINE CONTINUED

2COLOUR 
VIBRANCY 

It’s easy to 
over-toggle the 
Temperature 
and Tint bars to 
make something 
extra vibrant and 
completely change 
the colour of the 
image. I used them 
slightly on this 
image to improve 
the existing colours. 
I also used the 
Color Mix to bring 
out the vibrancy 
in the autumnal 
colours.

5MASKING 
PART 1  

Firstly, the sky: 

the exposures 
 

I added a mask to 
the sky, increasing 
Dehaze and 
reducing Texture, 
allowing the 
weather to be 
evident, but also 
to blend in with 
the rest of the shot 
by removing the 
previously ‘washed 
out’ sky.

1FIND A 
BALANCE 

Firstly, I reduced 
the Exposure and 

bring out more of 
the details that had 
looked ‘washed 
out’ in the lighter 

more depth to 
the background, 
and gave more 
layers to the shot. 
The increase in 
contrast will give 
better clarity when 
enhancing colours.

4APPLY 
HEALING 

I spent some time 
removing dust 
particles and 
spots before any 

is important, as 
it removes any 
distractions. Light 
colours often make 
them invisible in 
a raw image, and 
they’re more visible 
when Exposure 
is reduced and 
Dehaze increased.

3SHARPNESS 
AND DETAILS  

For this shot, I 
increased the 
Dehaze slightly 
for a darker and 

but also reduced 
the Texture to 
give it a smoother 
look. I opted not 
to add a Vignette 
to avoid taking the 
detail away from 

as that’s also an 
important feature 
of the shot. 

6 MASKING  
PART 2  

Secondly, the river: 
as a vital part of the 
image, I wanted it 
to have the right 

capture motion, 
and I wanted 
that motion to 
be evident, so I 
increased Clarity 
and Dehaze to 
enhance the 
movement. Texture 
is reduced in line 
with the rest of the 
image.

BALANCE TONAL RANGE Apply first-wave adjustments to raw files for a moody base image

Below
WASHED OUT 

The original shot appears 
overexposed and lacks depth. 

required straightening by 0.13 
degrees clockwise

Right
FINAL TOUCHES

Liam removed the sign 

any further treatment

AFTER

BEFORE
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UT R EF E A

he range of colours visible in a 
landscape scene is vast. Even 
under flat lighting or in seemingly 

drab locations, there are a plethora of 
analogous colours hiding in the scene – 
subtle variations, the sum of which creates 
a natural palette that the human eye can 
identify and relate to. This spectrum can 
be both a blessing and a challenge.

It’s one of the aspects that makes 
landscape photography so appealing, 
but it also means that becoming a deft 
hand at post-processing is a crucial skill. 
Over-working colour can break down the 
smooth gradations we’re accustomed 
to seeing and introduce uncomfortable 
jumps and shifts, which instantly make the 
scene look strange and unattractive.  

“Colour adjustment is a vital aspect 
within post-production, and plays a 
crucial role in enhancing and refining 
landscape images,” says nature 
photographer Mark Brion. “Remember, 
the goal of adjusting colours in a 

T

CREATE WITH COLOUR
Use colour adjustments to enhance the natural beauty of 
a scene, or to create a particular mood, says Mark Brion
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WHITE BALANCE 
I often use the Basic Panel sliders in Lightroom 
to correct colour casts, adjust the colour 
temperature of the scene and control the Tint 
for a more natural range of colours.

SATURATION AND VIBRANCE 
I use these tools to enhance or tone down 
colours, as they impact all colours and the least 
dominant ones, respectively. For more precise 
control, use Point Color or other sampling tools.

HSL 

Luminance sliders alter the shade, intensity 

COLOR GRADING 

based on the depth of colour. Independently 
add or neutralise colours in the highlights, 
midtones and shadows.

MARK’S MOST-USED  
EDITING TOOLS 

Top tools for editing landscape shots

BEFORE

landscape photo is to enhance its 

a particular atmosphere. Experiment with 
colour adjustments in post-processing, 
whilst keeping the scene intact. Assess 
your changes to ensure that they 
complement the overall aesthetics of 

AFTER

BEFORE

FLAT COLOUR I was struck by the vibrancy of the 
red mud in this scene, but it doesn’t show through 
in the out-of-the-camera shot

SUPER SEPARATION 
By selectively editing each colour 

channel and toning down the green 
leaves, the soil and bronze foliage 
stand out more, giving the image 

added three-dimensionality
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CREATE WITH COLOUR CONTINUED

1BLACK AND WHITE POINTS  

Option key to visualise when clipping starts to occur, setting the sliders 
to just before warnings appear.

2ADJUST HSL  
I needed to create separation between the green foliage and the 

bronze leaves and mud behind. To do this I reduced the yellow hue and 

luminance to remove the presence of sheen.  

3USE POINT COLOR  
To target the underlying reddish soil and brown foliage, I used the 

eyedropper in the Point Colour tab in Lightroom to select this range. 

further adjusted the HSL of these colours.

4GRADING WHEEL TECHNIQUES 
For a subtle split tone, I added green to the shadows and 

5TONE CURVE TARGETING 
Adding more complex tones to the colour palette ensures that 

creating a warm glow. 

6CONTROL CALIBRATION 
Finally, I made some minor adjustments to the colour process by 

increasing the green and blue primary saturation and shifting the green 
primary hue to the right. This completed the cinema-like grade style I 
was looking for.

COLOUR GRADE TO PERFECTION Balance grading to create images with maximum tonal separation



UT R EF E A

xposure and colour in 
photography are often 
discussed independently as 

if they’re unrelated topics; however, 
it’s important to remember that the 
brightness of an image directly impacts 
the appearance of colours. In landscape 
photography, the decision is often taken 
to underexpose slightly to maintain 
highlight detail but also to create richer 
colours that appear more saturated. This 
means that you need to be mindful of 
how your exposure choices affect the 
colour fidelity of your photos.

In scenic imaging, this can be 
challenging due to the tonal range of 
many compositions. The sky is usually 
brighter than the foreground by a 
significant margin, which means colours 
will be impacted differently in each 
area of the frame. This is why localised 
adjustments are hugely important in 
landscape editing. 

Most advanced software applications 
offer adjustment tools that allow 
you to make localised edits to many 
parameters, including exposure, colour 
saturation, white balance and clarity. This 
workflow is far more flexible than simply 
applying global adjustments. However, 

E

CRAFT LIGHTING AND EXPOSURE
Control tonal balance using local adjustment tools
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ESSENTIAL LOCAL 
ADJUSTMENT FEATURES
 Mark Brion’s pick of software tools

when we make changes to the tonality 
of an image, especially in local areas, we 
must keep the dynamic range natural. 
We must also ensure that we don’t 
change the lighting structure of the shot, 
creating hotspots where none could exist 
in reality due to the lack of a light source.

A professional approach is to work in 
rounds of edits that get progressively 
more concise. Start with global edits, 
then move down to working using local 
adjustment tools, before finally targeting 
the brightness and intensity of specific 
colour ranges.

AFTER

BEFORE

ON STREAM
The exposure range in this shot is wide, but the 
topography results in isolated areas of clipped 

NATURAL LIGHT
After making a range of localised 

adjustments, the image now 
contains much more detail and the 

dynamic range still looks natural

LOCAL ADJUSTMENT BRUSHES

make selective exposure adjustments.

GRADUATED FILTERS
Enables gradual exposure adjustments across 
the image, such as darkening the sky while 
keeping the foreground unchanged.

RADIAL FILTERS
Creates circular or elliptical selections with 
controllable feather measurements so you 

LUMINANCE RANGE MASKS
Layers and masks allow complex exposure 

Range masks allow precise tonal targeting.

DODGE AND BURN TOOLS 
These are commonly used to selectively lighten 
(dodge) or darken (burn) targeted areas based 
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CRAFT LIGHTING AND EXPOSURE CONTINUED

1AUTO BLEND SHOTS 
In this high-contrast scene, I captured a bracket of three exposures, 

which I then blended together using Lightroom’s Merge to HDR function, 
loading all of the tones into a single frame for later adjustment.

2 ADJUST MAIN PARAMETERS 
On the merged image, I set the black and white points, introduced 

some extra clarity, and pulled back some of the highlight detail. In 
order to monitor clipping, I toggled the clipping alerts by clicking on 

3ADJUST TONAL SHIFT 4RESTORE NATURAL COLOUR  
After adjusting the temperature of that range, the greens remained 

an ugly brown, so I adjusted them using HSL, increasing the green hue 
until the colours looked more natural. I also applied +33 green primary 
hue under Calibration.

5REMOVE GHOSTS  
The moving water has created blending artefacts, so I stacked the 

a selection around the foreground water in Quick Mask mode, feathered 
the selection and applied a layer mask.

6CREATE A LIGHT GRADIENT 
For a sunset feel, I added a Radial Gradient layer with a yellow 

foreground and magenta background and applied the Soft Light 
blending mode. For a smoother gradient, go to Layer Styles and, 

PERFORM COMPLEX BLENDS Merge images with challenging moving elements and tricky lighting



UT R EF E A

andscape photography can often 
be seen as a literal genre, with 
the aim of simply capturing the 

scene before the camera exactly as it 
is. However, this attitude has changed 
over recent years, thanks to the advent 
of social media trends, and AI software 
features such as Generative Fill in Adobe 
Photoshop. Although these tools can be 
controversial, and have stretched the 
definition of digital photography, they 
have also opened up a whole world of 
creative and cultural possibilities.

I’ve always believed that the impact 
of the final image is the end goal for a 
photographer, and that we must be free 
to take whatever steps are necessary 
so that the viewer can connect with 
our subject. If that means adjusting the 

L

WORK WITH SPECIAL EFFECTS
Explore advanced software techniques to make your shots stand out

MAXIMUM IMPACT
If getting people to connect with 
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colours and lighting conditions of a scene 
because they had less impact on the day 
we conducted our shoot, or because we 
had to shoot at a sub-optimal time of 
day, we should explore all the possible 
options to enhance our images. 

Modern software is packed full of 
filters and advanced functions, such as 
layer masking and gradients, which can 
be used to simulate exposure effects. 
The key is to use them with restraint, and 
only apply filters where there’s a clear 
advantage in doing so. Special effects, 
as in any photo genre, aren’t necessarily 
enough to justify an image on their 
own. Instead, they should enhance the 
lighting and detail already in the scene, 
or complement the intended tone of the 
shot at the moment of exposure.

MARK BRION
Mark Brion is an award-
winning photographer, 
based in Oxfordshire UK. 
He served in the British 
military and the police, 
before becoming a pro 

photographer in 2013. Initially, he worked 

imagery. Teaching photography is now 
Mark’s passion, and he leads workshop 

abroad.
@markbrionphotography 
markbrion.com

http://markbrion.com
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WORK WITH SPECIAL EFFECTS
CONTINUED

USE FILTERS LIKE A PRO Other special effect tools to try on your images

1ADD A MOVABLE LAYER 
Start by adding a black Solid Colour layer above your Background 

layer – the black background will make it easy to move the lighting 
2ADD A FLARE 

The process varies between software. In Photoshop go Filter > 
Render > Lens Flare. Select the 105mm Prime option, resize using 

3REMOVE THE BACKGROUND 

Screen to remove the black background, and then adjust the placement 

its direction.

4 MATCH THE AMBIENT COLOUR 

below, go to Layer > Create Clipping Mask. Check Colorize in the H/S 
dialog, and shift the Hue slider.

RELIGHT THE SCENE Introduce lighting effects to your shots to overcome flat conditions

DIFFERENCE CLOUDS 
In Photoshop, go to Filter > Render > 

blended using the Screen blending mode. 
Use this at an Opacity of less than 40%, and 
ensure the scaling matches the focal length 
of the frame.

RADIAL BLUR 
When shooting in the middle of the day, 
it can be a challenge to achieve a long 

Select the sky, and with the selection active, 
choose Filter > Blur > Radial Blur. Select 
Zoom as the method, and adjust the Amount 
to suit your image.

DIFFUSE GLOW  

Use this sparingly on high-key images 

Alternatively, go to Select > Color Range, 
sample a highlight and add a light Gaussian 



AVAILABLE ON YOUR DEVICE NOW!

To find out how you can get Photography Week delivered straight  
to your device every week for just a few pennies, simply search  

for Photography Week on any of the platforms below

SUBSCRIBE TODAY AND ENJOY 
PHOTOGRAPHY WEEK FOR 

 

S U B S C R I B E

http://bit.ly/2txbB2Bhttps://apple.co/2RjoI0a http://bit.ly/36kQ7TC

*Available for a limited time only. Standard subscription offer varies across platforms/devices – please refer to specific store for the most up-to-date offer

http://bit.ly/2txbB2B
https://apple.co/2RjoI0a
http://bit.ly/36kQ7TC


X P O S U R E
THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

MACRO MARBLES
NICK STRONG

“This is a close-up image of some marbles, which I shot in my home studio.”
https://bit.ly/3tXh6GI

https://bit.ly/3tXh6GI


THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

DARLING HARBOUR, SYDNEY, AUSTRALIA
PHILIP EDWARD WOOD

“This is the Darling Harbour Woodward Water Feature in Sydney, Australia. 
The angle of the sun against the wet spiral pattern caught my eye, inspiring 

me to capture my own interpretation of this piece of architectural art.”
https://bit.ly/3Ov32dU

https://bit.ly/3Ov32dU


THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

THE SILENT DISCO IN THE CLOUDS
DOM HAUGHTON

“Fanal Forest on the island of Madeira is an extraordinary location, quite 
unlike any other I’ve visited. Each tree has a unique shape and character, 
and it was fun to observe how they interacted with one another. In this 

image I saw a dancefloor, with the main subject strutting across the stage 
in front of a supporting cast. The fog that so often fills this high-altitude 

forest adds even more atmosphere to the scene.”
https://bit.ly/3AtIfBe

https://bit.ly/3AtIfBe


HARDWARE ART
KEITH TODD

“To photograph this collection of nuts, bolts, and screws I experimented by 
arranging them on a mirror, with two filtered LED lights off to the side.”

https://bit.ly/3RAkCyH

THE WEEK’S MOST INSPIRING READER PHOTOS

EL R YG A L

PHOTOGRAPHY WEEK WANTS YOUR PHOTOS! 
Taken a portrait you’re particularly proud of? Shot a sensational sunset you’d like to 
show off? Then join the Photography Week Facebook community and share your best 
photos today! You’ll get feedback from fellow readers and the Photography Week 
team, plus the chance to appear in Xposure, or even on our cover!

FACEBOOK
http://bit.ly/39py9lg

FLICKR 
http://bit.ly/2VIgsJO

https://bit.ly/3RAkCyH
http://bit.ly/39py9lg
http://bit.ly/2VIgsJO


  

he British Wildlife Photography 
Awards, which celebrate the 
incredible diversity of animals, 

plants, and ecosystems across the UK, have 
announced the winners of the 2024 contest. 

This year’s overall winner is Ryan Stalker, 
for his striking image of a football covered 

coast of Dorset after drifting across the 
Atlantic. The goose barnacle is a non-native 
species to the UK, normally being found in 

British Wildlife Photography Awards feature amazing images of fauna and flora 

the tropics, and the image illustrates how 
ocean waste can enable the migration of 
invasive species, as well as harming marine 
life and causing pollution.

Stalker’s image, entitled Ocean Drifter, 
also took first place in the Coast & Marine 
category. Other categories include Animal 
Behaviour, Animal Portraits and Botanical 
Britain. Click the link to see more winning 
and commended images at the British 
Wildlife Photography Awards website.

I T ’ S  C O O L ,  T H AT
THE BEST THING WE’VE SEEN THIS WEEK

I N S P TI R A OI N

PHOTO CONTEST CELEBRATES 
BRITAIN’S NATURAL WONDERS

T

Ocean Drifter by Ryan Stalker, Overall Winner

Three’s a Crowd by Ross Hoddinott, Winner, Hidden Britain

Tiny Forest Balloons by Jason McCombe, Winner, Botanical Britain

A Precarious Pose by Alastair Marsh, Highly Commended, Portraits
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SEE MORE IMAGES
ht tps : //b i t . ly/3INmiB6

https://bit.ly/3INmiB6


he Brenizer method is the 
brainchild of renowned 
wedding photographer Ryan 

referred to as the bokeh panorama, 
owing to the wide frame and super-
shallow depth of field that characterizes 
the style of these images. 

Bokeh panoramas boast shallower 
depths of field than are achievable 
with a wide-angle lens, and give APS-C 
and full-frame users the ability to 
produce portraits with a large-format 

aesthetic. The key to this technique 

achieve the characteristic portrait 
depth of field, and constant camera 
settings that won’t change between 
frames to create a seamless blend. 

Once you’ve settled on a white 
balance preset, locked your exposure, 
and used AF to focus on your subject, 
you need to switch to manual focus 
so as not to change your point of 
focus as you begin to shoot your 
panorama sequence. Exactly how many 

photos you take is down to personal 
preference, but we recommend 
overlapping each frame by around 30% 
to ensure you don’t leave any gaps.

your sequence by automatically 
merging your images together. You then 
simply need to check the blend for any 
inconsistencies, and crop as desired. 
If you like the idea of creating a wide 
portrait with a super-shallow depth 
of field, here’s how to shoot and edit 

PATCHWORK PORTRAITS
Mike Harris uses the Brenizer method to shoot and edit 

C R A S H  C O U R S E 
ESSENTIAL PHOTO SKILLS MADE EASY

S K I L   L   S

T



HOW TO SHOOT A BRENIZER

S K I L  L   S

QUICK TIP

shoot on a day with 
consistent sunlight 
or even cloud cover. 
Patchy clouds can make 
light conditions change 
between shots, which 
will make it harder 
to blend the images 
seamlessly.

A colourful, well-lit 
background produces 
vibrant tones for 
attractive bokeh

The spacious and 
interesting background 
lends itself to a large, 
medium-format-style 
composition

A super-fast 85mm 
prime is used to 
produce a shallow 

2

CONSISTENCY IS KEY
As you’ll be merging several frames, they need 
to be as consistent as possible. To prevent the 
white balance from changing mid-sequence, 
head to you camera’s White Balance menu 

and select the desired preset. We’d suggest 
shooting in raw so that you can tweak the 

colour temperature later if needed.

FAST LENS
A fast lens is essential for achieving a shallow 
depth of field: we used an 85mm f/1.4, but a 
50mm f/1.8 would also work well. You’re not 
limited to just prime lenses though – a fast 
telephoto zoom, like a 70-200mm f/2.8, will 
still produce a suitably blurry background.
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HOW TO SHOOT A BRENIZER

S K I L  L   S

FRAME YOUR SHOT
You’ll have plenty of room to crop your large panorama 

in post-production, but you should still consider your 

enough space to crop, though, as your blended image 

MANUAL FOCUS
Your focus needs to be consistent throughout your 

simply release the back button after you’ve focused on 

locked as you capture your bokeh panorama.

CAMERA SETTINGS
Select aperture priority mode and choose a wide 

higher). Now switch to Manual mode, and input the same 

SHOOT THE SEQUENCE 
We framed and captured our subject, and then shot three 
frames to her left and three frames to her right, and three 

more frames just above her head and three below her feet. 
There’s no hard and fast rule for how many or how few 

image by around 30% to prevent any gaps between frames.
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1  OPEN IN CAMERA RAW
the first image, hold down Shift and select the 
last image), then right-click and select Open 
in Camera Raw. Hold Shift and select the last 

your edits will now be applied to all the images.

3  IMPORT INTO PHOTOSHOP
With the images still selected, click Tools > 
Photoshop > Photomerge. Make sure Auto and 
Blend Images Together are selected when the 
Photomerge window opens, and click Browse 
to select the images from your sequence. Hit 
OK to start the merging process.

5  CROP YOUR IMAGE
Your image will likely a rather irregular shape, 
so fix this using the Crop tool. It’s worth 

multiple frames, so you have plenty of room to 

2  COLOUR TEMP
Select Remove Chromatic Aberration and 
Enable Profile Corrections in the Lens 
Corrections tab, then check the exposure and 
colour temperature of each image, ensuring 
that you fix any inconsistencies before 
blending your panorama. Click Done. 

4  BOKEH PANORAMA
You’ll now have a large medium-format-
style image that’s spliced into multiple layers. 
Photoshop generally does a good job of blending 
images together, but it’s worth looking for any 
obvious inconsistencies, which you can rectify 
with the Clone Stamp or Healing tools.

6  FLATTEN AND FINISH
Make a flattened copy of your image by 
selecting the topmost layer and pressing  

You can then proceed with your normal editing 
regime to finish the image off.

HOW TO EDIT YOUR BOKEH PANORAMA

S K I L  L   S

QUICK TIP
Working with 
multiple raw 

challenge even 
for powerful 
computers, 
especially if 
you’re using an 
extremely high-
resolution camera. 

do the bulk of 
your editing in 
Camera Raw 
before saving the 
images as JPEGS, 
which enables 
you to control 
the size of your 

and selecting 
the JPEGS in 
Adobe Bridge, 
and following the 
same blending 
process. Another 
way to reduce 
the workload on 
your computer 
is to take fewer 
images – a 
panorama portrait 
can be as few as 
two images. 



P H O T O S H O P 
LEARN ESSENTIAL EDITING SKILLS FAST!

E D I T I N G

This powerful tool has more to it than meets the eye, and it’s ideal for landscapes

hotoshop’s Shadows/
Highlights command has long 
been one of the most useful 

landscape photo will be dominated 

detail hidden in the highlights and 

the Shadows/Highlights command is 

P

HOW TO...

MASTER SHADOWS AND HIGHLIGHTS

DOWNLOAD THE 
PROJEC T F ILES 

ht tps : //b i t . l y/3w1de4h

ON A P C OR M AC

WATCH THE V IDEO 
ht tps : //b i t . ly/3EwS1D4

https://bit.ly/3w1de4h
https://bit.ly/3EwS1D4
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www.viltroxstore.com £420/$545

he Viltrox AF 27mm F1.2 Pro 
picks up the baton from some 
seriously good f/1.4 lenses 

that are available in Fujifilm X, Nikon 
Z and Sony E mount options. We 
were impressed by the Viltrox AF 
23mm F1.4 Z, Viltrox AF 33mm F1.4 Z 
and Viltrox AF 56mm F1.4 Z, which 
are all pretty much the same size and 
weight, plus the slightly larger Viltrox 
AF 13mm F1.4 Z. Personally, I was so 
impressed by these four lenses that 

lenses for when I’m shooting with my 
Nikon Z fc camera.

Combining fast and consistently 
accurate autofocus with good 
handling characteristics, Viltrox’s 
back catalogue of lenses include 

terrific value at the price, although 

the 23mm, 33mm and 56mm lack 
weather seals. The newer 27mm lens, 
which so far is available in Fujifilm 
X and Nikon Z mounts, sets the bar 

fast f/1.2 aperture, along with a feast 
of upmarket features. It’s naturally 
bigger and heavier than the trio of 
23mm, 33mm and 56mm f/1.4 lenses, 
and getting on for twice the price, but 
is still standout value for money.

Key features
The 27mm focal length of this 

viewing angle of 55.3 degrees. It’s 

lens, but not quite as wide as a 

terms). I find the focal length works 

T

L E N S  T E S T
EXPERT OPINION ON THE LATEST KIT

A ‘pro’ lens with a consumer price tag

VILTROX AF 27MM F1.2 PRO

1 Viltrox’s HD Nano multi-layer coating is 
applied to the lens.

2 There’s no locking switch, but the aperture 

3 The USB-C port can be used for applying 

well for everyday walkabout shooting 
and street photography.

A key feature of the lens is its 

This enables a tight depth of field, 
which is always more challenging 

bokeh comes to the fore and, to help 
maintain good bokeh when stopping 

http://www.viltroxstore.com


LENS TEST VILTROX AF 27MM F1.2 PRO

down a little, the lens features a 

aperture diaphragm. A further bonus 
of the speedy aperture rating is that 
you can retain fast shutter speeds for 
freezing action, even under gloomy 
or indoor lighting conditions.

As we’ve come to expect from a 

based autofocus system, it enables 
fast autofocus for stills, as well as 
being adept at delivering smooth 
and virtually silent transitions 
when shooting video. The optical 
path is based on no less than 15 

on the other previously mentioned 
Viltrox lenses.

Build and handling
Build quality feels consummate with 
the lens’s ‘Pro’ label. The construction 
is based on a metal casing and a 
coated brass mounting plate, and 
unlike the 23mm, 33mm and 56mm 
lenses, this one features a full set of 
weather seals. There’s also a AF/MF 
focus mode switch, which is quicker 
and more convenient to use compared 
to delving into camera menus to make 
the change. Another welcome addition 

neatly under the thumb, and which we 

One criticism of the 23mm, 
33mm and 56mm lenses is that the 
aperture ring has no click steps and 
no locking switch, and it was easy to 
inadvertently nudge the ring from its 
Auto position to a narrow aperture 
setting. The 27mm still has no locking 
switch, but there’s a much firmer 
‘click’ from the Auto position, and 
throughout our testing we found that 

elements, arranged in 11 groups. To 
maximise sharpness and clarity while 
minimising unwanted aberrations, 

low Dispersion) elements. Viltrox’s HD 

minimise ghosting and flare.
A neat feature in terms of ensuring 

compatibility with forthcoming 

you can use for applying firmware 
updates. It’s an update over the 

This shot, taken wide open at f/1.2, 
demonstrates the Viltrox’s good control over 

axial/longitudinal chromatic aberration or 

vignetting at the corners of the frame

Bokeh discs from defocused lights look Defocused areas look soft and smooth, with a 
natural transition in the roll-off between areas



LENS TEST VILTROX AF 27MM F1.2 PRO

we didn’t engage manual apertures 
accidentally, not even once. 
Furthermore, the aperture control 

more ideal for stills, along with a 
Click on/off switch, enabling stepless 
aperture control for video.

The lens comes complete with a 

a stylish soft pouch for stowage. The 
filter attachment thread of 67mm 
is pretty modest for an f/1.2 lens, 

actually the same size as on the 
13mm F1.4 lens, but larger than the 
52mm thread shared by the 23mm, 
33mm and 56mm F1.4. The lens 
measures 82 x 92mm and weighs 
560g – that’s noticeably larger and 
getting on for twice the weight of the 
f/1.4 trio of 23mm, 33mm and 56mm 
lenses, bu itt feels manageable and 
well balanced on slimline Fujifilm and 

Performance
Autofocus is quick, virtually silent, 
and proved consistently accurate in 

our tests with a Nikon Z fc. Naturally, 
though, fast autofocus and great 

quality doesn’t hit the spot, and we’re 
happy to report that the Viltrox shines 
through with excellent sharpness 

bears up well even at the extreme 
edges and corners of the image 
frame. As an aside, we used the lens 
to shoot some product photography, 
and it was sufficiently sharp to draw 
attention to even the smallest 
lettering and microscopic particles 

For creative photographers, the 
quality of bokeh is arguably every bit 
as important as sharpness, and the 
Viltrox does very well in this respect. 
Defocused areas in images look soft 
and smooth, with a natural transition 

and defocused parts. Bokeh discs 
produced by defocused pinpricks 
of light and other bright points are 
smooth and have soft outlines, 
although they take on irregular 
shapes away from the centre of the 
image frame, which is common.

noticeable axial/longitudinal chromatic 
aberration when used at their widest 
apertures, and this shows up as 

transitions in scenes, just in front of and 
behind the plane of focus. The Viltrox 
does well to keep this aberration to 
a minimum, and the same goes for 
lateral chromatic aberration, which is 
more commonly a problem towards 
the edges and corners of the frame, 

There’s very little distortion, but 
vignetting can be noticeable when 
shooting at the widest aperture, 
although this might actually be 
viewed as attractive from a pictorial 
point of view. Either way, it can be 

corrections if desired.
All in all, performance is excellent 

and entirely consistent with the lens’s 
‘Pro’ tag, and it holds its own against 

more to buy.
Matthew Richards

MOUNT: FUJIFILM X, NIKON Z FULL-FRAME: 
NO LENS CONSTRUCTION: 15 ELEMENTS 
IN 11 GROUPS ANGLE OF VIEW: 55.3º 
AUTOFOCUS: YES MAX APERTURE: F/1.2 
MIN APERTURE: F/16 DIAPHRAGM BLADES: 
11 MIN FOCUSING DISTANCE: 0.28M MAX 
MAGNIFICATION RATIO: 0.15X FILTER 
SIZE: 67MM DIMENSIONS (L X D): 92 X 
82MM WEIGHT: 560G

For such a fast f/1.2 lens, sharpness is 

wide open, and it holds up very well even out 
to the extreme edges and the corners of the 
frame. From f/2 through to f/8, corner 
sharpness is simply epic.

SHARPNESS

FRINGING  0.56

DISTORTION  -0.91

There’s very little lateral chromatic aberration, 
even at the edges and corners of the image 
frame, throughout the entire aperture range. 
The lens also keeps a tight rein on lateral/
axial chromatic aberrations, scoring very well 
on both counts.

There’s just a slight hint of barrel distortion 
but, as with lateral chromatic aberration, 

in-camera corrections.

VERDICT
We’ve been impressed by the 

lenses from Viltrox for Nikon Z DX 

mirrorless cameras. The new 
27mm F1.2 sports a ‘Pro’ badge, 
and takes everything to a new 

level. It offers superb build quality, 

fast f/1.2 aperture, and delivers 

round performance. And there’s an 
extra wow factor in the price – we’d 
happily pay three or four times as 

much for a lens of this quality.

The lens comes with a petal-shaped, 
bayonet-fit hood, plus a stylish soft pouch 
for stowage
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to improve your photography with  
an inspirational mix of amazing 
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N-PHOTO
N-Photo is a monthly magazine for 
Nikon photographers, and is packed 
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